The protocol for moving hypertext files across the Internet. Requires an HTTP client program on one end, and an
HTTP server program on the other end. HTTP is the protocol used by the World Wide Web (WWW).



The main communications protocol in the Internet suite of protocols that provides reliable, connection-oriented, full
duplex streams and uses IP for delivery.



Action messages are brief descriptions of what you want the other users to picture you doing. For example, if
another user says something funny, you might post the action message “Raven giggles”. Action message are
automatically preceded by your nickname, so write your action in the third person. For example:

*Raven waves hello to everyone



Private action messages are sent only to the specified user, preceded by your nickname. For example:
*> Raven winks at you secretly ...

Your nickname does not appear in the Action field, but it will be the first word of your action message.



Points to a specific Web site.



A file that contains characters other than the standard ASClicharacters. Binary files cannot be read like text files;
they are usually executable programs or compressed files.



An abbreviation for American Standard Code for Information Interchange. This standard code consists of 7 data
bits (or binary values) per character. Letters, numbers, and special characters (for example, $,y,#, %) are

represented by different ASCII codes. The ASCII character set represents 96 printable characters and 32 non-
printable control characters.



A Cyberjack bookmark object that as acts a direct shortcut to an Internet site. You can create CyberLinks to your
favorite sites, and send them to other users through email. Also, any URL you can takes you to another site when
you double click it is also a CyberLink.



Hypertext Markup file. This file type can be read directly by Cyberjack Web.



A pointer to remote sources on the Internet.



Control the way you search by selecting Exact, Case Sensitive, Case Insensitive or Regular Expression.



When lurking, you are watching the chat to learn more information about the terms and expressions used in the
chat.









The status of Cyberjack Ping’s search for the specified Internet address.



The result of Cyberjack Ping’s last data packet sent to the specified Internet address.



The average response time, in milliseconds, of a returned Cyberjack Ping data packet.



Click to have Cyberjack Ping send data packets to the specified site.



Type the site for Cyberjack Ping to diagnose.






Select the item to change its appearance.



Select a new size for the selected text item.



Select a new color for the selected text item.



Select a new font for the selected text item.



Returns the color, font and size of all items to their default settings.









Type the new URL.



Type a description for the folder.



The number of subfolders in the current folder.



The number of objects in the current folder.



The name of the current folder.



Type a description for the current folder.



Enable to password protect the Guidebook.



Click to change your password.



Type a description for your Guidebook.



The default icon for the Cyberjack object.



The name of the URL or object.



The type of URL or object.



The number of times this object has been run since you created it.



The last time this object was run and modified.



The URL of the object.



The IP address of the object.



Type your current password.



Type your new password.



Type your Guidebook password.



Type your new password again to confirm it.



The type of URL the object contains.



Click to start the search.



Click to stop the search.



Click to clear all the fields.



Displays all found objects.



Choose a folder to start the search in.



Enter a substring of the name of the object you want to find.



The number of days previous to this date you want to search.



The number of days previous to this date you want to search.



Choose a top level Guidebook to look in.



Enable to include all subfolders in the search.



Click to browse the folders in the Guidebook.



Click to search all objects.



Click to search by date.



Click to search for objects created or accessed between the specified dates.



Click to search objects created or accessed between the specified months.



Click to search objects created or accessed between the specified days.



Type the date you want to start searching from.



Type the date you want to stop searching at.



Select the number of months previous to the current date to search.



Select the number of months previous to the current date to search.



Select the type of object you want to find.



Type the string to be searched in the object descriptions.



Enable to select the number of times an object was run.



Select the number of times an object has been run.



Select the number of times an object has been run.



Enable to find objects according to how many times they have been run.



Type the address of the Guidebook server to connect to.



This animation starts when you start the find and stops when it is finished. You can use it to see if the find is still busy.



The default icon for the current Cyberjack object.



Click to ping the selected site.



The address of the site that you will connect to. In some cases, e.g. News, IRC, Archie, it will be the default server you always
connect to.



The date the object was created or last accessed.



Use the tabs to add criteria to the search.






Enable any item in this list to display the selected toolbar. You can edit or delete any selected toolbar.



Click to edit the currently selected toolbar.



Click to create a new toolbar.



Click to delete the currently selected toolbar.



Enable to display buttons in color.



Enable to display Tooltips when the mouse cursor is placed over a button.



Enable to display large buttons.



Enable to display Delrina WinFax style buttons.



Enable to display Delrina WinFax style captions for buttons.



Add or remove buttons from the selected toolbar. Click the name of the toolbar to change its name.



Type a new name for the toolbar.



Use these buttons to make up your toolbar. You can drag them up to the toolbar, or click the Add button.



Adds the button highlighted in the available field to the toolbar above.



Removes the button highlighted in the above toolbar.



Resets the toolbar to its original(default) settings.



Lists the menu options that can be assigned to the buttons.



Specifies the caption that is to be displayed when Delrina Classic button style is chosen with captions.



Specifies the tooltip that is to be displayed for the button.



Specifies the help text that is to be displayed for the button.



Save the changes to the toolbar and continue.



Throw away changes to this toolbar.



Type the path and name of the folder to receive all downloaded files.



Enable to confirm overwriting existing files.



Enable to view partial images as they are downloading.



Enable to open files when they are downloaded.



Enable to show the Transfer Summary window when files are downloaded. Use this window to open or delete files.



Enable to minimize the transfer dialog. The minimized dialog appears at the bottom of the screen.



Enable to change the default name of files before downloading them.



Enable to flash the icon of a minimized Cyberjack program on the Windows Task Bar when files are downloaded.



Enable to maximize a minimized Cyberjack program when files are downloaded.



Enable to play a Windows system sound when files are downloaded.



Enable to notify you when each file transfer in a group transfer is complete.



Enable to notify you when a group transfer is complete.



Enable to set up the type of notification you want when files are downloaded.



Specify how you want to be notified after group transfers.



Browses for the folder to receive all downloaded files.



Specify the options for file transfers.



Enable to check for viruses in the downloaded files.






Your password for the Guidebook.



Your password for the Guidebook.



Lists the folders and files in the selected location.



Lists the folders and files in the selected location.



Type the name of the file.



Type the name of the file.



Selects the type of file to save.



Selects the type of file to save.



Opens the file with the name, file type, and location you specified.



Saves the file with the name, file type, and location you specified.



Creates a new CyberLink.



Creates a new folder.



Links you to another Guidebook on your computer system.



Links you to a Guidebook on a remote system.



Displays the properties of selected CyberLink.



Sends the Guidebook by email.



Imports URLs from Netscape bookmarks or text files.



Exports URLs to a Cyberjack Guidebook (.gbk), Netscape bookmark file (.htm) or a text file (.txt).



Closes the program and returns to the Windows desktop.



Recovers the last deleted CyberLink.



Cuts selected text to Clipboard.



Copies selected text to Clipboard.



Inserts contents of the Clipboard to your Guidebook.



Deletes selected text or items.



Renames selected item.



Selects all items.



Selects all previously unselected items.



Finds specified text.



Shows or hides toolbars.



Shows or hides Status Bar.



Repositions splitter bar.



Displays items as large icons.



Displays items as small icons.



Displays items in a list.



Displays detailed list of items.



Sorts items by name.



Sorts items by address.



Sorts items by program type.



Sorts items by automatically arranging them.



Aligns items with each other.



Shows or hides the Alphabet Tabs. Enable the Alphabet Tabs to organize CyberLinks alphabetically.



Shows or hides the Type Tabs. Enable the Type Tab to organize CyberLinks by program type.



Reloads items displayed in the window.



Checks your connection to an Internet site.



Displays contents of Download folder.



Connects you to an Internet site.



Starts your email program.



Changes toolbars and password in the Guidebook.



Starts Online Upgrade Wizard to retrieve any available patches or upgrades from the Delrina Upgrade Server.



Displays contents of Guidebook Help Topics only.



Displays contents of Cyberjack Help Topics.



Starts Tip of the Day for tips on how to use Cyberjack.



Registers your copy of Cyberjack.



Displays program information, version number and copyright.



Stops data transfer.



Click the What's This button, and then click a menu command or screen component to receive context sensitive help.






Lists the available folders and files.



Lists the folders and files in the selected location.



Type the name of the file.



Selects the type of file to save.



Closes this dialog box without saving any changes you have made.



Saves the file with the name, file type and location you specified.



Tell me about the Guidebook

The Cyberjack Guidebook is a personal organizer for storing connections to your favorite Internet
sites. Entries in your Guidebook are saved as CyberLinks. Each CyberLink contains the address of a
specific Internet site and details about the Cyberjack program used to connect to that site.

The Guidebook comes with hundreds of CyberLinks from the World Wide Web, Internet Relay Chat
(IRC), Gopher, FTP and newsgroups. Use the Guidebook as your starting point for navigating the
information highway.

From the Guidebook, you can select a Cyberjack program and cruise to your destination, stopping at
interesting sites along the way. You can also double click a CyberLink to take the express route directly
to a particular site.

As you travel the Internet, you can save any site to your Guidebook as a CyberLink with one click on
the toolbar. You can add folders to your Guidebook to customize how you store CyberLinks. You can
protect the Guidebook with a password.



Cyberjack Guidebook
To start a Cyberjack program from the Guidebook

. On the Start menu, click the Cyberjack program you want to start. The Cyberjack program starts.
Tip
- From the Guidebook, you can access all Cyberjack programs. If you are not sure where to start, try using

Cyberjack Web and connect to the Cyberjack Web page, at:
http://www.cyberjack.com/



Cyberjack Guidebook
To connect to a site using a CyberLink
1. In the folder area, click the folder to open it.

2. In the display area, double click the CyberLink. The relevant Cyberjack program starts and connects you to the
site.



Cyberjack Guidebook
To find a CyberLink

On the Edit menu, click Find. The Find All Objects dialog appears.
Click the Name & Location tab.
In the Named field, type part or all of your search word.

Enable Include Subfolders.
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Click Find Now. Cyberjack searches for CyberLink names that contain your search word.



Cyberjack Guidebook
To send the Guidebook by email

1. On the Guidebook menu, click Send. Your email program starts and displays the Guidebook as an attachment
in the message window.
2. Compose your message.

3. When you are ready to send the Guidebook, send the email message.

Note

- For details about using email with Cyberjack, click here

>



Cyberjack Guidebook

To link to a Guidebook on your local system

1. On the Guidebook menu, point to Attach, and click Link to Guidebook. The Attach Guidebook dialog appears.
2. Use the Look in drop-down list to find the folder that contains the Guidebook you want to link to.

3. Click the Guidebook file, and click Open. The Guidebook window opens.

[0 Related Topics



Cyberjack Guidebook
To link to a Guidebook on a remote system

1. On the Guidebook menu, point to Attach, and click Remote Guidebook. The Select Guidebook Server dialog
appears.

2. In the drop-down list, click the remote server from which you want to retrieve the other Guidebook and click
OK. Cyberjack links to the other Guidebook on the remote server and displays it in the folder area.

3. To view the CyberLinks in the remote Guidebook, click the Guidebook.

O Related Topics



Cyberjack Guidebook
To remove a link to a Guidebook on a remote system

1. In the Guidebook folder area, click the link you want to remove, and click the Stop button on the toolbar. The
Guidebook on the remote system is disconnected from your Guidebook.

2. On the Edit menu, click Delete. The link to the remote Guidebook is removed.

[ Related Topics



Cyberjack Guidebook
To create a new folder

1. On the Guidebook menu, point to New and click Folder. A New Folder entry appears in the folder area.

2. Type the name of the folder.

[0 Related Topics



Cyberjack Guidebook
To add tabs to a folder
1. On the View menu, enable Alphabet Tabs. The alphabet tabs appear in the display area.
2. In the folder area, double click a folder to open it.
3. Inthe display area, click an alphabet tab. For example, click the tab ...
def

... to display the names of CyberLinks beginning with the letters “d”, “e” and “f.”
4. On the View menu, enable Type Tabs. The type tabs appear in the display area.
5. Inthe display area, click a type tab. For example, click the Web Page tab to display your Web CyberLinks.

[0 Related Topics



Cyberjack Guidebook
To create a CyberLink using a specific program

1.
2.

4.

In the Guidebook folder area, click the Guidebook folder in which you want to create the CyberLink.

On the Guidebook menu, point to New and click the type of CyberLink you want to create. The New dialog for
the program appears.

Type the URL and click OK to create a CyberLink. You may be required to type additional information in the
“New” dialog, depending on the Cyberjack program.

To refresh the window display after creating a CyberLink, click Refresh on the View menu.

Note

You do not need to connect to Internet sites to create CyberLinks—you can create them by entering URLSs.

[ Related Topics



Cyberjack Guidebook
To create a CyberLink without selecting a program

[N

. Click a Guidebook folder to insert the CyberLink.

N

On the Guidebook menu, point to New and click Address/URL. The Type in the URL dialog appears.
3. In the Universal Resource Locator (URL) field, type the address. For example, type ...
http://www.cyberjack.com/
... to create a Web CyberLink to the Cyberjack home page.
4. Click OK. The CyberLink is created in the folder you currently have open.

[0 Related Topics



Cyberjack Guidebook

To import URLs from Netscape bookmarks or text files

1. In your Guidebook, click the folder in which you want to import the URLs.
2. On the Guidebook menu, click Import. The Import URLs dialog appears.

3. Inthe Look In drop-down list, open the appropriate folder and click the bookmark file or text file you want to
import.

4. In the Files of Type drop-down list, click the file type of the URLs.
5. Click Open. The Importing dialog appears.

Cyberjack imports the bookmark file or text file to the Guidebook folder. If you need to stop the transfer, click
Cancel.

[ Related Topics



Cyberjack Guidebook

To export the Guidebook URLs

1. On the Guidebook menu, click Export. The Export URLs dialog appears.
2. In the Save In drop-down list, click the folder you want to export to.

3. Inthe Save as Type drop-down list, click the file type. You can export to a Cyberjack Guidebook file (.gbk),
Netscape bookmark file (.htm) or a text file (.txt).

4. In the File Name field, type a name for the file you are exporting. You can also type *.* in this field to see all the
files in the folder.

5. Click Save to export the file.

[ Related Topics



Cyberjack Guidebook

To configure a password

On the Setup menu, click Options. The Guidebook Options dialog appears.
Click the General tab.

Enable Password-protect this Guidebook.

Click Change. The Change Password dialog appears.

In the Old password field, type your old password.

In the New password field, type a new password.
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In the Confirm new password field, type the new password again.

Note

For security reasons, the characters contained in your password are displayed as asterisks. Make sure that
the number of characters displayed matches that of your actual password. If the number of characters does not
match, erase the password and retype it.









